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IMPORTANT NOTE 
 

 
Read and understand this manual  prior to using this instrument. 
 
This instrument should be inspected and calibrated by qualified and trained  
technicians. 
 
This instrument has not been designed to be intrinsically safe. For your safety, 
DO NOT use it in classified hazardous areas (explosion-rated environments). 

 
    
     
 
INSTRUMENT SERIAL NUMBER: ______________________________________________ 
 
 
PURCHASE DATE: ___________________________________________________________ 
 
 
PURCHASED FROM: _________________________________________________________ 

 
 
 
 

WARRANTY POLICY 
 
 

YES Environment Technologies Inc. warrants this instrument to be free from    
defects in materials and workmanship for a period of two years, including       
sensors, from the date of purchase by the original owner. If the product should  
become defective within this warranty period, we will replace/repair it at our   
discretion.  
 
The warranty status may be affected if the instrument has not been used and 
maintained as per the instructions in this manual or has been abused, damaged 
or  modified in any way. This instrument is only to be used for  purposes stated 
herein. The manufacturer is not liable for  auxiliary  interfaced equipment or  
consequential damage. 
 
Due to ongoing research, development and product testing, the manufacturer 
reserves the right to change specifications without notice. The information     
contained herein is based on data considered accurate. However, no warranty is 
expressed or implied regarding the accuracy of this data. 
 
All goods must be shipped to the manufacturer by prepaid freight. All returned 
goods must be pre-authorized by obtaining a return merchandise authorization 
(RMA) number. Contact the manufacturer for a number and procedures required 
for product transport.  
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NOTICES 
 
 

Copyrights: This manual is subject to copyright protection; all rights are reserved. Under 
international and domestic copyright laws, this manual may not be copied or translated, in 
whole or  in part, in any  manner  or format, without  the  written  permission of YES    
Environment Technologies Inc. 
 
All software which YES Environment Technologies Inc. utilizes and/or distributes, holds a 
proprietary interest and is also subject to copyright protection and all rights are reserved. 
No party may use or copy such software in any manner or format, except to the extent 
that YES Environment Technologies Inc. grants them a license to do so. 
 
 
 

REVISIONS 
 
 
This manual was written and published by YES Environment Technologies Inc. (the 
manufacturer). The manufacturer makes no warranty or representation, expressed or 
implied including any warranty of merchantability or fitness for purpose, with respect to 
this manual. 
 
Should you detect any error or omission in this manual, please contact the company at 
the following address: 
 
YES Environment Technologies Inc. 
Unit 145, 7391 Vantage Way 
Delta, BC V4G 1M3 
Canada 
 
Toll free:  1-877-940-7007 
Phone: 604-940-7007 
Fax: 604-940-7044 
E-mail: info@yestek.com 
Website: www.yestek.com 
 
In no event will YES Environment Technologies Inc., or it’s officers or  employees be  
liable for any direct, special, incidental or consequential damages resulting from any   
defect in any manual, even if advised of the possibility of such damages. 
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WELCOME 
 
 

Thank you for purchasing our YES-206LH multi-sensor, indoor air quality monitor. The 
YES-206LH series of instruments are easy to use monitoring and data recording  devices 
for monitoring trends in air quality. 
 
The YES-206LH is equipped with built-in temperature and humidity sensors to aid in veri-
fying gas readings providing a comprehensive indication of indoor air quality. Data     
readings are stored in a built-in, self-powered, programmable data  logger with bullet-
proof memory to protect your data and a sample rate that is adjusted using the supplied 
software. The instrument may be hand-held or will easily stand on a flat surface. 
 
Calibration and repair is available at our manufacturing facility and through some of our 
authorized distributors. 
 
The YES-206LH can reliably record time-based data, which can be downloaded via ACR 
Trend Reader software, onto any computer capable of running Microsoft Windows 95 or 
higher (with an available serial communications port). 
 
If after reading through the manual, you have any questions, please do not hesitate to 
contact our service department for technical support. 
 
 
 

MODEL DESCRIPTION 
 
 
MODEL  DESCRIPTION 
 
 
YES-206LH Three integral sensors: CO2, Temperature, Humidity 
 
 
Note-1: See specifications section (pages 9 -10) for list and specifications for 
              available toxic gas sensor options 
 
Note-2: The previously available model YES-206L has been discontinued. 
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YES-206LH SHIPPING CHECKLIST 
 
 
This checklist ensures that you have received everything required to run your IAQ     
monitor / logger. If you do not receive any of the items listed below, contact the factory 
immediately: 
 
 

• YES-206LH multi-gas monitor/logger 

• ACR TrendReader software 

• Communications cable 

• AC wall adapter 6V @ 400 mA 

• Carrying case 

• Calibration accessories (hose & coupling) 

• Operation manual 

• Other specified accessories (please refer to original sales order and the comments 
below): 

 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
___________________________________________________________________ 
 
 
Date: __________________  Checked by: __________________________ 
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1.0  GENERAL 
 
 

The YES-206LH is a battery powered, portable indoor air quality (IAQ) monitor - logger. A 
basic instrument includes a two-line LCD alpha numeric display, rechargeable battery 
pack, built-in programmable data logger, three sensors (Carbon Dioxide, Temperature 
and Relative Humidity), carrying case and basic accessories. 
 
 
2.0  SPECIFICATIONS 
 
 
Physical:  a) Dimensions: 3” (76 mm) Wide X 6.5” (165 mm) High X  
  2” (51 mm) Deep 
 
  b) Weight: 13 ounces (370 g) 
 
Construction: Rugged ABS plastic enclosure with vented cover 
 
Power:  Internal: Rechargeable, lead acid battery pack 
  Continuous: Plug-in, 6VDC wall adapter 
 
Visual:  Two-line LCD alphanumeric display 
  Push-buttons for user access 
 
Option:  Internal, automatic sample pump (for CO2 only) 
 
 
 
Minimum System Requirements to Operate Data Logging Software: 
 

• Personal computer 

• A Pentium II class processor or better 

• 4MB RAM 

• A VGA monitor 

• An open COM port 

• A hard disk with at least 1 MB of available disk space. Additional space is required to 
store logger files and graph files. 

• Microsoft Windows 95 or higher 

• Mouse (recommended) 
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2.0  SPECIFICATIONS, CONT’D….. 
 
 

The YES-206LH instruments use the Non-Dispersive Infrared (NDIR) method of detect-
ing Carbon Dioxide. This method is based on the principle that Carbon    Dioxide absorbs 
infrared energy at uniquely characteristic frequencies. The technique involves determining 
the difference in infrared energy absorption over all wavelengths passed by the optical 
system between a gas sample cell, containing the Carbon Dioxide compound and a    
pre-set reference path. 
 
In the YES-206LH, a broad band infrared source emits energy, which is filtered, to   pro-
duce a narrow range of frequencies characteristic of the Carbon Dioxide absorption spec-
tra. The “band filter” allows for only those frequencies that are  absorbed by Carbon Diox-
ide, to pass into the detector while blocking all other frequencies. Carbon Dioxide located 
in the gas-sample cell selectively absorbs   energy propagating to the detector. 
 
This change in energy is detected, amplified and sent to the signal-processing portion of 
the system. It’s measurement range of 9,999 ppm covers the range required to monitor 
compliance  with ASHRAE or other ventilation efficiency standards. 
 
Note: The CO2 sensor installed is specified to be accurate to within 5% of the reading. 
The unit has been designed to exhibit minimal output drift for long periods of time.     
However, annual calibration verification is strongly recommended to ensure the continued 
satisfactory performance of this device. 
 
 
 
CO2 SENSOR SPECIFICATIONS: 
 
 
Operating Principle  Non-dispersive infrared (NDIR) 
 
Gas sampling method: Diffusion (standard) 
   Sample Draw (option) 
 
Measurement Range: 0  -  9,999 ppm 
 
Resolution:  1 ppm 
 
Long Term Drift:  +/- 100 ppm 
 
Response Time:  >1 minute for 90% step change 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 2 years, 1-year for best accuracy 
 
Operating Temperature: 0o  to + 50o C 
 
Operating Humidity:  0% to 95% non-condensing 
 
Operating Life:  10 years 
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2.0  SPECIFICATIONS, CONT’D….. 
 

 
TEMPERATURE & HUMIDITY SENSOR SPECIFICATIONS: 
 
 
Gas sampling method: Diffusion (standard) 
 
Measurement Range: Temperature: 0 - 50oC (32o to 122o F) 
   Humidity: 0 - 100% RH 
 
Resolution:  Temperature: 0.1O C 
   Humidity: Better than 0.4%  
 
Accuracy:   Temperature: +/- 0.5o C 
   Humidity: +/- 2% 
 
Warm Up Time @ 22o C 5 minute operational, 20 minute for maximum accuracy 
 
Calibration Frequency: 2 years, 1-year for best accuracy 
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3.0 INSTRUMENT EXTERIOR PHOTOGRAPH 

ENCLOSURE 
VENTS 

ALLOWING AIR 
AND CO2 TO  
DIFFUSE TO  
INTERNAL  
SENSORS 

6.5” 
(165 mm) 

3” 
(76 mm) 
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3.1  INSTRUMENT BACK PANEL PHOTOGRAPH 

ENCLOSURE 
VENTS 

ALLOWING AIR 
AND CO2 TO  
DIFFUSE TO  
INTERNAL  
SENSORS 

CALIBRATION 
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WARNING LABELS 
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HERE 
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3.2 INSTRUMENT SIDE PANEL PHOTOGRAPH 

PORT FOR FLOWING 
NITROGEN ZERO 

GAS AND CO2  
SPAN GAS 

SOCKET FOR 6V 
WALL ADAPTER 

SERIAL PORT FOR 
CONNECTION TO 

COMPUTER 

INSTRUMENT VIEW IS TO THE 
LEFT OF THE DISPLAY 

2” 
(51 mm) 

TEMPERATURE AND  
HUMIDITY SENSORS 

ARE LOCATED INSIDE 
THE INSTRUMENT 
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4.0 DISPLAY 
 
 
Carbon Dioxide and temperature are displayed on the LCD display. Carbon Dioxide is 
displayed on the first line in “ppm”, to a maximum of 10,000 ppm. Temperature is        
displayed on the second line in degrees “C” or “F”. 
 
The following are other modes of operation visible on the LCD display and accessible 
through the front located push-buttons. 
 
Warm-Up Mode: When the power button is pressed, the monitor enters a one-minute 
warm-up cycle indicated by the word “Warm-Up” in the upper left corner of the display. 
 
Normal Operating Mode: After warm-up, the sensors have stabilized and the current 
measurements are displayed. Note: Relative Humidity is measured and data logged but 
not indicated on the LCD display. 
 
Elevation Setting Mode: This feature allows the user to correct the Carbon Dioxide sensor 
for elevation changes. 
 
“Calibration In Prog Mode”: The message is displayed when calibration is in progress. 
 
 
 
 
ALPHANUMERIC LCD DISPLAY 
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4.1 EXTERNAL CONNECTIONS 
 
 
Serial Port (COM port) 
 
This port allows the user to connect the instrument to the computer with the supplied 
communications cable to download recorded data. The cable attaches to any serial port 
on the computer. (Reference photos on page 12). 
 
 
Power Jack 
 
This allows the user to plug in the supplied 6V wall adapter to charge the internal  battery 
or operate the instrument continuously for long periods of monitoring and recording.  
Without external power, the internal battery will operate the instrument for approximately 
2 hours. 
 
Note-1: In order for the main battery to be properly recharged, the YES-206LH must be 
plugged into the AC adapter for approximately 12 hours. 
 
Note-2: “Important Battery Life Information”; In order to preserve the life of the internal 
lead acid battery, DO NOT discharge the battery to 0% unless it is absolutely mandatory. 
70% maximum discharge is optimal. Please use only the  supplied AC adapter for this 
purpose. 
 
 
Calibration Port 
 
This is a fitting to which the user attaches the calibration hose for the purpose of         
calibration or gas testing. 
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5.0  INSTRUMENT OPERATION 
 
 
Power-Up 
 
Press the “power” button and the display will become visible within approximately 2     
seconds. The CO2 value will be displayed within approximately 10 seconds. “Warm-Up” 
will be displayed for approximately 1 minute. During this entire period, adjustments cannot 
be made to the instrument through the push-buttons. 
 
 
Elevation Correction 
 
The sensor is shipped with the elevation setting set at “0” or sea level. The CO2     sensor 
is affected by altitude changes. If you are at an altitude greater than 500 feet, an  adjust-
ment should be made to assure sensor accuracy. To change the default setting, using 
Elevation Correction, follow these steps: 
 
1) While in normal operating mode, press the “mode” button once. “ELEVATION” will  
begin flashing. Next, press “enter”. 
 
Press the “mode” button to toggle the displayed elevation reading between feet (ft.) and 
meters (m). 
 
Use the “▲” / “▼” buttons to adjust the altitude. The altitude can be adjusted in           
increments of 500’ (100 meters). Once the correct altitude is displayed, press “enter” to 
lock the setting and return to normal operation. 
 
 
Display in Fahrenheit or Celsius 
 
To change the temperature to read in Fahrenheit or Celsius or to turn off the temperature 
display, use the “▲” / “▼” arrow buttons. 
 
 
Setting and Using the Internal Data Logger 
 
The internal data logger should be adjusted to desired logging settings before instrument 
use. Refer to the   
 
 
Stand-Alone Monitoring 
 
Once the battery pack has been charged and the elevation correction has been made, the 
sensor will begin to accurately display current room conditions. 
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6.0 CALIBRATION 
 
 
The sensors utilized in the YES-206LH have a specific life span (refer to specifications    
section)  and require regular calibration throughout their life span to maintain best       
accuracy. The calibration procedures described on the following pages provide the user 
with step-by-step instructions in how to achieve calibration of all sensors with the        
exception of temperature and humidity. It is recommended that a trained technician     
perform these tasks.  
 
 
CO2 SENSOR 
 
 
Equipment required: 
 
 

• CO2 span gas (1000 ppm suggested) with balance N2 

• Calibration hose and fitting (supplied) 

• Cylinder regulator with pressure gauge and fixed flow rate of 0.1 or 0.2 LPM 
 
Note: A standard YES calibration kit is recommended 
 
 
One-Point Span Calibration 
 
1) Press the “Mode” button until the word “CALIBRATION” flashes on the display. 
 
2) Press the “Enter” button, to go into the calibration menu, two readings will be shown, 
the current reading will be shown on the top portion of the display, and the one point   
calibration setting will be shown on the bottom 

CALIBRATION 
SWITCH 

ACCESS HOLE 

CALIBRATION 
GAS PORT 

FIGURE-1 
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6.0 CALIBRATION, CONT’D….. 
 
 
3) Insert hose with brass coupling (included) and tighten onto “Calibration Gas Port”,   
located on the top left side of the instrument. Refer to figure-1 photo on page 23. Flow 
Gas at 0.2 LPM. 
 
4) Using Up/Down buttons, adjust the one-point calibration setting to match your gas       
concentration. 
 
5) Insert the supplied clear plastic rod through the calibration switch access hole (refer to 
figure-1 photo on previous page) and hold it for 4 to 5 seconds until the word 
“CALIBRATION” begins to flash on the display. 
 
6) Press the “Enter” button on the front of the instrument and the words “CALIBRATION 
IN PROGRESS” starts flashing. 
 
7) After approximately 5 minutes of averaging the readings, the “CALIBRATION IN   
PROGRESS” message will stop flashing and that indicates calibration is complete. 
 
8) Press “Enter” button to accept the settings and return to normal operation display. 
 
 
Calibration of Temperature 
 
 
An accurate temperature reference will be required to make this adjustment 
 
Push the “Mode” button until the word “Temperature” begins to flash on the display. 
 
Push the “Enter” button and “Temperature” will begin to flash. Adjust the temperature 
value with the Up/Down arrows until it matches the your reference. 
 
When the desired reading is reached, press the “Enter” button to accept the setting and 
return to the normal operation. 
 
Note-1: Calibration of relative humidity sensor cannot be achieved through instrument 
push-buttons. Please contact manufacturer. 
 
Note-2: Zero calibration of CO2 sensor cannot be achieved through the instrument push-
buttons. It can only be achieved with the use of software which can be obtained from the 
manufacturer. 
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7.0 DATA LOGGER OPERATION 
 
 
INTRODUCTION 
 
 
All YES-206LH instruments are supplied with a powerful, built-in, programmable, 12-Bit 
data logger. The data logger is manufactured for YES by ACR Systems and utilizes the      
famous TrendReader software. The data logger will record data accurately and reliably 
over long deployment periods and in widely varying environmental conditions. 
 
TrendReader is the interface software that communicates with our data logger and   
transfers the recorded samples to a PC. The data can then be viewed as a graph file and 
exported to an Excel spreadsheet. The following section outlines the basic use of Trend 
Reader software. A more detailed description can be found on the Trend Reader manual 
on the supplied cd. 
 
Before being able to use the TrendReader software, it must first be installed onto the hard 
disk of your computer. Once TrendReader has been loaded on your PC, it allows you to: 
 

• Configure your YES-206LH data logger 

• Display real-time values 

• Transfer logger values to your PC and create logger files 

• View and print graph files 

• Export graph files into databases or spreadsheets 
 
 
INSTALLING TREND READER FOR WINDOWS 
 
 
1) Start Windows 
 
2) Insert the CD ROM, supplied with your instrument, into your CD ROM drive. Note: This 
CD will not auto run. 
 
3) Click on Trend Reader folder and execute the file “tsf1p21”. The Trend Reader screen 
will appear. Click “ok” to continue, then follow the instructions on the screen. Once the 
installation is complete, move to the next step. 
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7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
USING TREND READER FOR WINDOWS 
 
 
Now that TrendReader has been installed, it can be started by clicking on the icon or 
going to start, programs, ACR data logger software, Trend Reader Standard 1.21, Trend 
Reader Standard v1.21 (full). 
 
Screen Layout: The layout of the TrendReader screen is shown below: 

NOTE: When the instrument is switched off, the data logger continues to record valid  
temperature samples unless you attach the instrument to the computer and disable it. 
 
 
 
SETTING UP LOGGER TYPE 

 
 
 
 
From the 
Communicate 
menu click on 
“Preferred 
Logger (RF)” 
and select “4)
SmartReader 
Plus via RF” 
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7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
 
SETTING UP YOUR COMPUTER’S SERIAL PORT 
 
 
The Trend Reader software automatically detects an available COM port. No manual 
COM selection is required. 
 
 
DATA LOGGER SELECTION 
 
 
Click on “COMMUNICATE” tab on tool bar and select “PREFERRED LOGGER (RF)”. 
Select “4) SMART READER PLUS RF”. 
 
CONNECTING THE YES-206LH TO THE PC 
 
 
Ensure the YES-206LH is switched off prior to performing the following connection.    
Connect the male end of the supplied DB-9 cable to the female connector of the YES-
205, and connect the female end to an open 9-pin COM port on your PC. If your computer 

NOTE: THERE WILL BE  MORE COM PORT 
TABS ON THE SCREEN IF AVAILABLE IN 
YOUR PC. 

 
NOTE: When the instrument is switched off, the data logger continues to record valid  
temperature samples unless you attach the instrument to the computer and disable it. 
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7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
Once you click on “OPEN COM”, the software will start scanning the port for a connected 
YES-206LH. 

7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
CONNECTING THE YES-206LH TO THE PC, CONT’D….. 
 
 
While the TrendReader software is attempting to establish communication with the      
instrument, the YES-206LH LCD display will indicate “REMOTE HOST MODE”. 
 
Once communication has been established, Smart Reader Plus dialogue box will appear 
(see next page). SMART READER automatically starts in real-time mode by default. 
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SETTING SAMPLE INTERVALS 
 
The software allows you to change sample rates on your YES-206LH to suit the          
requirements of your application. You can set up faster sampling rates to capture rapidly 
changing data or space out your readings to maximize memory and cover extended  
monitoring periods. To change the sample rate on your currently-connected YES-206LH, 
Click on “Sample Rate” and select desired sample rate. Note: Ensure that you are in 
“Edit Setup” mode before doing this. 
 
Minimum Sample Interval:  8 seconds 
 
Maximum Sample Interval: 8 hours 

7.0 DATA LOGGER OPERATION, CONT’D….. 

NOTE: BEFORE ATTEMPTING TO 
CHANGE ANY SETTINGS, YOU MUST 
CLICK ON EDIT “SET UP” TAB TO 
TOGGLE TO SET UP MODE 

NOTE: BY CHECKING “STOP WHEN FULL” 
BOX, THE LOGGER WILL STOP SAMPLING 
WHEN IT IS FULL. YOU MUST CLEAR THE 
DATA BEFORE PROCEDING 
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7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
DATA TRANSFER 
 
To transfer logged data from the YES-206LH to  the PC, click on “Back Up” tab and the   
following dialogue box will appear. 

Data is transferred into a temporary memory location. The following dialogue box will 
prompt you to specify the file name and location to save the data for future reference. 
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7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
DATA TRANSFER, CONT’D….. 
 
Once data has been saved to the specified location the following graph file will           
automatically open. Each channel will be displayed in a different colour for easier       
identification. 
 

WORKING WITH GRAPHS 
 
 
The Difference between Logger Files and Graph Files 
 
TrendReader usually follows the Windows style of handling files. There is, however, one 
important difference: how TrendReader distinguishes between logger file and graph files. 
 
Logger files 
When you copy a logger’s data to your computer using the backup function, TrendReader 
will automatically save all the data (internal and / or external channels) in one file.      
TrendReader calls this file a logger file and gives it a.TRW extension. 
 
 
Graph files 
 
When you open a logger file and choose one or more channels, a graph will be displayed. 
If you make any changes or add any comments to the graph give it a name and save it, 
TrendReader will save the graph as a graph file. It will give the file the .GPW extension to 
signify that it is a graph file. To find this file the next time, open the graph file dialog box. 
DO NOT move a logger file once it is created and saved. The graph file will not be able to 
find it and will not open. Try to move the logger file before you create any graph files. 
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7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
Never delete a logger file just because you have a graph file from the logger file’s data 
and you think that you don’t need the logger file anymore. A graph file cannot exist on its 
own. Every time you open a graph file it has to get data from its logger file(s) in order to 
open. 
 
To View Logger Data without altering it: 
 
If, when you open logger files, all you do is view the information (as a graph or table) and 
sometimes print the information, you don’t have to bother with graph files. When you have 
finished viewing or printing a graph or table, close it. If you want to look at it again, open 
that logger file again. 
 
As long as you don’t alter it and save it under another name, you can open and close a 
logger file as many times as you like. 
 
Opening Logger files to display graphs: 
 
When you open a logger file from the File menu, the Open Logger File dialog box will  
appear. 

TrendReader’s display of logger files in this dialog box departs slightly from the usual 
Windows style of displaying files. A logger file name is displayed in capital letters and the 
names of its channels are displayed below it in lower case letters. The dialog box above 
is displaying two of the sample logger files that come with the TrendReader software. The 
filename of the first logger is Eg. 57172.TRW. This file contains data from three external 
channels. It looks as if these channels are separate files, but they are not. They are all 
part of the file Eg. 57172.TRW. 
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7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
Opening Logger files to display graphs, Cont’d….. 
 
57172.TRW is the name that the user gave to the file, and “.TRW” is the extension that        
TrendReader gives to every logger file. 
 
Choosing logger channels for graphing 
 
TrendReader allows you to combine readings from different logger channels on a single 
graph. These readings can be from the same time period, from different time periods, 
from one logger, or from different loggers. 
 
To choose channels, open the Open Logger File dialog box from the File menu. In this 
box, a name in capital letters is a filename and refers to a logger. The information from 
the various channels of that logger is listed after the filename. All the data from a logger is 
in one file. 
 
From the Open Logger File dialog box: 
 
    To choose a single channel to display as a graph, click that channel and then click OK 
 
    To choose more than one channel, click the channels you want to highlight, and click       
    OK. You may choose channels from different loggers. 
 
     To choose all channels from one logger file (one logger), click the filename (all that                    
     file’s channels will be highlighted). Click OK  
    
     To deselect all channels from one file, click the filename. 
 
     To deselect any individual channel(s), click the channel(s) to remove the highlighting. 
 
When you have chosen the channel(s) you want to display as a graph, click OK 
 
 
Opening a Graph File 
 
If you have opened a logger file previously, made changes to the graph, given it a name, 
and saved it, the file is now a graph file. (The original logger file still exists.) 
 
To open this file again: 
 

1- From the File menu, choose Open Graph File. 
2- From the Open Graph File dialog box, choose the file you want. 
3- Click OK  

You can make changes to a graph file, but you cannot combine different graph 
files and display them as one graph. If you want to combine data from different 
logger channels or from different loggers onto one graph, you can do this only 
with logger files. Open logger File dialog box and combine your data from there 
by clicking on the channels you want to display on one graph. 
 

 



28 

7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
A Graph Window 
 
Whether you have opened a logger file or graph file, your graph will be displayed in the 
graph window. 

The status bar 
 
The status bar, at the bottom of your screen, displays data relating to the coordinates of 
the cross hairs on the graph. As you move the cross hairs with the mouse you will see the 
coordinates changing on the status bar. 
 
Showing the legend 
 
The legend (the names of the channels that are displayed on the graph) appears to the 
right of the graph when there is a check mark in front of the legend on the View menu. 
 
Enlarging a graph Window 
 
When you open a graph file,the graph window will not be displayed at its maximum size. 
You can make it fill the whole screen by clicking the maximum button in the top right   
corner of the windows. 
 
The maximum button will become a restore button. 
 
Closing graph window [Ctrl+F4] 
 
To close a graph window, either press Ctrl+F4 or click the control-menu box in the top left 
corner of the window, and choose Close from the pull down menu. 

LEGEND 

GRAPH 
TITLE 

GRAPH 
FILE 
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7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
Zooming 
 
The zoom function magnifies the horizontal axis (the time axis ). It does not affect the 
vertical axis. The zoom function enables you to magnify a section of a graph so that you 
can see it in greater detail. The zoomed area becomes the full width of the graph,     
therefore the narrower the section you choose to zoom, the greater the magnification. 
 
There are two ways to zoom: by using the mouse, or by specifying the start and end time 
of the zoom from the Graph Zoom dialog box. You may zoom more than once. 
 

A. Using the mouse to zoom in on a section of a graph: 
 

1. Position the cross hairs to the left of the area that you want to     
magnify. (It doesn’t matter where you place the cross hairs vertically). 

2. Press and hold the left mouse button and drag to the right. The    
vertical lines that appear will be the boundaries of the magnified area. 

3. Release the mouse button when you have enclosed the area that you 
want to magnify. 

 
B. Using the Graph Zoom dialog box to zoom in on a section of a graph: 
 

1. Click anywhere below the graph. The Graph Zoom dialog box      
appears. 

2. Type the new time and date. Change AM or PM if necessary. 
                         3.     Click accept. 
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7.0 DATA LOGGER OPERATION, CONT’D….. 
 
 
WORKING WITH GRAPHS, CONT’D….. 
 
 
Unzooming [Ctrl+Z] 
  
To view the graph at its original scale, go to the View menu and choose Unzoom X-Axis. 
 
 
Copying a graph to the clipboard [Shift+Ins] 
 
Copy a graph to the clipboard is an extremely fast and easy way of transferring a graph to 
another Windows application, for example, to a word processing program, where it can be 
included in a report. Copy Graph to clipboard is on the Edit menu. 
 
The clipboard ( a temporary storage area ) is a Windows feature; you can read about it in 
your Windows guide . 
 
As an example, we will transfer a graph to a word processing program. 
 

1. Open the graph that you want to place in the word processing program. 
2. From Edit menu, choose Copy Graph to Clipboard. 
3. Press Alt+Tab to transfer to Program Manager. 
4. Open the Accessories window and click Write. 

     5.     When the word processing program opens, choose Paste from the Edit menu.    
             The graph will be copied from the clipboard to the word processing program.         
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7.1 TROUBLE SHOOTING TREND READER SOFTWARE 
 
 
Why won’t Trend Reader Communicate with my logger? 
 
If logger does not respond when communication is attempted, check that: 
 

• The logger or modem is attached to the selected COM port 

• All connections are secure between the computer and the logger 

• There are no other applications using the COM port 

• Only one serial port is hardware configured for each COM designation 

• There are no conflicts IRQ assignments 
 
If the logger still does not work, try: 
 

• Testing the serial port with another application 

• The software on another computer 

• Other loggers or interface cable 
 
 
Why Won’t Trend Reader back up my logger? 
 
If the software cannot back up the loggers data, make sure there is enough room on the 
hard drive to store the data 
 
 
Why do my graphs have the wrong time and date on them? 
 
This happens if your computer clock is incorrect when you back up the logger. The Trend 
Reader depends on your computer having the correct time and date. If your graphs have 
the wrong time and date you can: 
 
Under Windows 95, 98, NT or 2000: 
 

• Set clock on the computer by: 
 1. Double click on Windows time display in the bottom right corner of the 
      screen 
 2. On the date/time properties window, change the time 
 3. Click apply 
 

• Correct the original file by choosing “revise a logger file” from the option menu. 
Change the back up time/date to the actual time you backed up the logger. 
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7.1 TROUBLE SHOOTING TREND READER SOFTWARE 
 
 
How accurate are TrendReader time measurements? 
 
There are two answers to this question. The first answer describes the relative accuracy 
of each reading. The second answer describes the absolute accuracy of the reading. 
 
 
Relative Accuracy 
 
Relative time measurements in normal mode (the time that elapse between one reading 
and the next reading) are precise to within +/- 2 * sample rate/24 * 3600. The accuracy of 
the clock inside the logger is +/- 2 seconds per day. 
 
 
Absolute Accuracy 
 
TrendReader absolute time accuracy (the difference between the time the data logger 
took a reading and the time that TrendReader reports the reading was taken) depends 
upon the time base in the logger. The absolute time of TrendReader’s reading are       
accurate to within +/-4 seconds. 
 
When you back up your data, the logger is unable to tell TrendReader precisely when it 
stored it’s last reading. Trendreader only knows the current time and the elapsed time in 8 
second intervals.  
 
 
What rights are needed to run TrendReader on a  network? 
 
The method of granting rights varies according to which network operating system is be-
ing used. You should have the following rights: 
 

• Create 

• Erase 

• Search 

• Modify 

• Read 

• Write 
 
(or their equivalent) to both the TrendReader for Windows and the file path directory used 
to store data. 
 
 
Why can’t I print from TrendReader? 
 
1. Make sure the printer is powered and on-line by checking that it is plugged in and the 
associated lamps are on. 
 
2. Check that the printer cable is connected to the appropriate port on your computer. 
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7.1 TROUBLE SHOOTING TREND READER SOFTWARE, CONT’D….. 
 
 
Why can’t I print from TrendReader?, Cont’d….. 
 
3. Try the printer’s self-test function by clicking on start, settings, printers and right click 
on desired printer’s property. Click on print test page tab. If the printer fails the self test, 
contact your administrator. 
 
 
Why can’t I contact my data logger over the network? 
 
You probably don’t have SR+ network checked “on”. 
 
 
 
 



34 

THIS PAGE HAS BEEN LEFT 
BLANK ON PURPOSE 

 



35  



36  


